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Introduction

EDI — Electronic Data Interchange is a structured Document standard and is one of the most
widely used standard in Business-to-Business communication. The various modes of
exchanging an EDI data are using the well-known exchange protocols such as AS1, AS2,
and VAN.

Purpose

The main purpose of this book is to get basic understanding of the EDI standards, learn
Oracle Fusion Middleware B2B EDI support, User experience while configuring EDI protocol
using Oracle B2B, Various Error/Exception scenario and also to model the various EDI
messages using Oracle B2B Document Editor.

After reading this book, users should be able to independently model Various EDI use cases
such as batching, debatching and end-to-end scenario using various EDI message types and
revisions.

Audience

EDI Cookbook is intended for B2B users who want to exchange EDI messages such as
EDIFACT, X12 using Oracle B2B as an Integration Gateway product and would like to
understand various use cases and implementation.

Prerequisite
Basic Knowledge of EDI Standard i.e. both X12 or EDIFACT is a must.

Assumptions
This document is based on Oracle Fusion Middleware B2B 11g R1
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What is EDI

Electronic Data Interchange is a Structured Business to Business Document standard which can
be Electronically exchanged between and with in the Enterprise. EDI standard define the structure
of the Business document for e.g. Purchase Order, Invoice etc. Even though itis a flat file
standard unlike the popular XML standard, it is difficult to replace EDI due to its wider adoption
and customer base.

Advantages of EDI
e Well-defined structure for handling various Business processes.
e Matured standard as it addresses every complex use case in various Business domains.
e Wider adoption and increased customer base.
e Matured, well-defined, EDDIINT standard such as AS1, AS2 for data exchange.

EDI Document structure

The below picture explains the EDI document structure by taking X12 and EDIFACT
document.

Interchange Control Header {ISA 'UNE) |

Functional Group Header (GS /UHG) |

Transaction Header (ST /UHH) |
Transaction
Envelope
Transaction Header (SE /UHT) |
Inter change Group
Envelope Emelope
Transaction Header (ST /UHH}) |
Transaction
Envelope
Transaction Header (SE /UHT) |

Functional Group Trailer {GE /UHE } |

Interchange Control Trailer (IEA | UHZ) |

Please refer to any Basic EDI tutorial for Document organization.

EDI documents can be grouped based on some unique criterion and contain Group sender,
Group recipient etc. Which is unique to the group. Multiple Group can be enclosed in an
envelope called Interchange. Group is not mandatory in EDI world, and is possible to enclose the
documents directly under Interchange.
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Sample X12 file

ISA~00~Authorizat~00~Security I~0l~Interchange
Sen~0l~Interchange Rec~071105~2249~U~00401~849818414~0~I~~
GS~PO~Ap~Ap~20071105~2249~83~T~004010

ST~850~2604

BEG~00~AB~P~~20071105

PO1~123

SE~4~2604

GE~1~83

IEA~1~849818414

EDI Support in Oracle B2B

Oracle B2B supports both the EDIFACT and X12 flavor of EDI. Oracle Integration B2B has
teamed up with EDIFECS™ to provide their robust translation and validation engine as an
integral part of Oracle Integration B2B. This solution provides:

A library of ALL EDIFACT, X12, HL7, HIPAA, EANCOM, NCPDP Script transaction sets
Data file validation

Data Migration

Tests data generation

De-Identification

Dictionary generation

Batching

Guideline migration

User Experience while configuring EDI protocol in Oracle B2B
The following are the steps to configure an EDI document in Oracle B2B.
o |dentify the Document to be exchanged with the Trading Partner; it includes EDI

Standard, Document Type and Document Revision.
e.g. Standard X12, Document Type : 850 Document Revision : 4010

- Goto Administration
-> Select Document

- Select Document Protocols
- Select EDI_X12

e Create the ecs file based on the document to be exchanged using Oracle B2B
Document Editor. Please refer to the Document Editor Section

e Export the ecs file to get an XML schema file. Schema is used by the application, where
as ecs file is used in B2B.

/ Note: While exporting, select the option to export in Oracle B2B 2.0 format

e Define Document Revision, Document Type and Document Definition for configuring a
specific EDI Document.
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Create a Document Protocol Version

- Click (+) icon in Document Protocol pane to Add Document Protocol Version

ORACLE' B2B Administration | Partners | Reports | Metrics | Help

Logged in a5 weblogic

Types | Import/Export [ Scheduie Batch | 1 atch | Callout " Purge [ Listening Channel | Configuration
© Documents % % | [EDocument protocol Version Save | New Type

|5 [ Document Pratarols.

58 custom

58 Ep1_FOIFACT

= 38 EnLxi2 EDI_X12-NewVersion
3 Newversion| Speciy the versian for the document protocal, After the new version is saved, you can create a new docmen type.

=L

5 oss * verson e (4510

58 PostionalFlatFie Description

38 Rosettatist

58 et

Reset Parameter

Interchange " Group | Delimiters

‘Authorization Information Qualfier | oo Interehange Control Standard/Repetition Separstor |4
Aukhorization InFormation * Inkerchangs Cantral Version Murber | o401
Security Information Qualfier | o Usage Indicator |p

Interchange Date | #SystemDate(YVMMDD)
Inkerchange Time | #5ystemTime(HHMN)#

-> Provide the Version name (4010)

Field Value
Version Name 4010

- Save the newly created Document Protocol version
- Observe the confirmation message after save activity

Create a Document Type

ORACLE B2B ‘Administration | Partners | Reports
Logaed i
Deploy | Manage Deployments [ Types | Import/Export [ Scheue Batch | Manage Batch | Calout | Purge | Listening Channel " Configuration
£l Documents e Document Type Save | New Defintion
[= [ Document Protocols
Custom
[58 eor_eorract
& [+ Ep1_x12 [EDI_X12-4010-NewDocumentType
= & 4010 Spacy the document typs For this version. After the nesw bype s saved, you can crests a e documert: defition,
LY Document Typ tiame (50
& one Deseription

58 positionalFlatFie
[ Rosettatiet
58 ucche: Reset Paramater

Transaction

* Functional Group Identifier Code [pe
Implementation Convention Reference

Transaction Purpose Code

- Select newly created Document Protocol Version (4010) in Document Protocol pane
- Click (+) icon to Add Document Type

- Provide the Document Type Name (850)

-> Provide the Functional Group Identifier Code (PO)
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Field Value
Document Type Name 850
Functional Group Identifier Code PO

-> Save the newly created document Type

Create a Document Definition

-> Select newly created Document Type (850) in Document Protocol pane
- Click (+) icon to Add Document Definition
- Provide the Document Definition Name

ORACLE’ B2B Administration | Pa

Document ¢ ort Expart e Batd anage Bakch | Callout °[ Purge °|[ Listening Channel | Configuration

[ Documents x® ’E Document Definition Save
51 [ Document Protocols
Custom

33 eor_eorFact

= (38 e01 012 [ED1_X12-4010-850-NewDefinition
B @ 4010 Enter the document definition name and and ssiect the required defirition file
sll= D  Diefintion 1
B FenpeEma jacument Definkion Name | 350def

& 057 Description
&8
38 ons
58 PostionalFlatFie Defintion g50,xsd | Update..
38 Rosettatist Rt %50 Name
58 et

i Reset Parameter

Transaction )| Routing [ #Path | Correlation
* Tranzaction Set ecs Fie | CAB2E materias\119 A1 Samplest [ Browse.. ]

- You have the option of providing an xsd corresponding to the transaction set ecs , which can
be used in the back end application such as BPEL for required transformation to edifecs.xml.

- Provide the Transaction set ecs file, under “Transaction” tab. This is mandatory. It is best

practice to create the ecs file using the document editor 6.6.1 However, both B2B and document
is backward compatible. Refer to the section “Document Editor”

Enter the following information

Field Value
Document Definition Name 850def — a name os user choice
Definition 850.xsd

The xsd file can be created using
the Spec Builder 6.6.1 by exporting
the ecs file in Oracle B2B 2.0
format

Transaction set ecs file 850.ecs
- Click Save

- Observe the confirmation message after save activity

If it is required to process a functional acknowledge, create another document definition for
the document Type (997) with the following information
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Field Value

Document Definition Name 997def — a name of user choice

- Observe the xsd and ecs files are already being uploaded. As this is a common document
type, it has been made part of default configuration. However, it is also possible to upload the ecs

Update. ..
and xsd files for 997 by clicking \i‘ button with below mentioned

Field Value

Definition 997.xsd
The xsd file can be created using the
Spec Builder 6.6.1 by exporting the ecs
file in Oracle B2B 2.0 format

Transaction set ecs file 997.ecs

-> Save the newly created Document Definition

ORACLE' B2B Administration | Par
Document T <[ Types [ Import checle Batch | Manage Batch | Callout " [ Purge [ Listening Channel | Configuration
= Documents xR E Document Definition Save
= [ pocument Frotocols @ confirmation:
58 custom 997def has been saved,
[ Ep1_FDTFACT
& [ Epr iz EDI_X12-4010-997-997def
= & 010 Enter the and and definiian File.
= & ss0
[ ss0def Document Definition Name  997dsf
B & gar Deseription
[ [997def
B
3 one Definition  567,xsd | Update. .
33 positionalFiatFie ROt 5D Name
(53 Rosettatiet
38 uccner
4 Reset Parameter
Transaction | Routing | Path | Correlation
Transaction Set ecs Fle 997 ccs | Update.,.

e As part of document definition, use ecs file and xsd files obtained from previous step.

B2B uses only the ecs file for validation and translation; xsd can be used by
BPEL process for payload validation and can be accessed by composite while
configuring the communication between BPEL and B2B. Please refer to the EDI
Tutorial for the detailed steps.

e Define Document Protocol Parameters
Document Protocol Parameters are defined while creating the document protocol
version, however it is possible to override it for a specific Trading partner

For e.qg. the list of delimiters, option to create the UNA segment etc while defining the
Document Protocol Revision
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Interchange .. Group | Delimiters

Create UNA | always Interchangs Time

Synkax Identifisr | NGB Recipient's Reference/Passward

Syntax Yersion Number Recipient's Reference/Password Qualifisr

Service Code List Directory Yersion Number Application Reference

Character Encoding Processing Priovicy Code

Interchangs Date | #SystemDake{YYMMDD)#

#SyskemTimelHHMM )4

Interchangs Agresment
Test

Interchang

e Document Type Parameters while defining the Document Type i.e. Transaction set.

e Standard Interchange and group ecs files are seeded in the product. Unless there is
any change in the ecs file due to customization of any of the envelope segments, B2B
will always refer to the seeded ecs files. For any change in the Interchange or group
segments, it is required to redesign the respective ecs using the Document Editor,

use it in B2B as group/Interchange ecs file.

// Note: It is required to validate and redeploy the agreement for any change in

Document parameters.

e Add these documents to the trading partner with the respective role (initiator /
responder). All the documents that are defined are available for Host by default. Just

need to assign the proper role for the host

Add Documents definitions for responder

- Click “Documents” tab to add the document definition
-> Click (+) icon in Document pane to add Document definition to the trading Partner

| & GlobalChips

Docum| Select Document Definition

B Custom

[38 EDI_EDIFACT
B [a8 EpI_X12
= 3@ 4010

B &5 850

Definity

= &3] 997
[l 997def
33 H7
0AG
[38 PositionalFlatFile
(33 RosettaNet
(38 uccnet

@

Add

]

Cancel

Add the documents that are spedific to this trading partner. All documents that the host creates are available to add to the trading partner's profile.
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- Add the document to the trading partner

-> Select appropriate role for 850def (sender / receiver), depending on the business usecase
- Click Save

Similarly,
- Select appropriate role for 997def (sender / receiver), depending on the business usecase
- Click Save

Documents

& Globalchips
Add the documents that are specific to this trading partner. All documents that the host creates are available to add to the trading partner's profile,
[ confirmation:

EDI_¥12-4010-997-997dsf has besn saved.

Documents 4
Definitions Sendsr Receiver
EDI_%12-4010-850-550def
EDI_%12-4010-997-997def 1
Document Details Reset Parameter

¥ersion " Document Type | Defiritions
Interchange .. Group | Delimiters

Authorization Information Qualifier | og Interchange Contral StandardiRepetition Separator |1
Authorization Information * Interchange Control Version Number | 00401
Security Information Qualifier | gg Usage Indicator [p
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Outbound EDI Processing

B2B can receive 2 types of EDI documents from Back end Application.

e Native EDI:
B2B acts as a gateway doing the validation of the document and forwards it to the
respective trading partner using designated exchange protocol. This approach does
not provide typical of the EDI features such as Batching and generation of the
Interchange and group as appropriate. Hence it is required to send the complete
envelope for B2B processing.

This approach requires disabling the translation flag while creating the agreement, as
B2B acts as a gateway, forwarding the document to the TP.

In this mode no correlation will be done with respect to functional acknowledgment.

e XML: Itis required by the back end application to get the data from downstream
application and transform it to xml as defined by the schema.

Back end application is required to send only one transaction set at a time to B2B as
B2B generates the envelope using the pre-seeded envelop details. If the Back end
application has an envelope with multiple Transaction Sets, it is required to split the
same into multiple transaction and enqueue it to be processed by B2B.

Alternatively, it is also possible to override the Document Protocol Parameter defined
in B2B for a specific Document Type and Revision by specifying the Internal Property
in the Edifecs XML. For e.g the elements with <Lookup tag will be used for validation

<Internal-Properties xmIns="http://www.edifecs.com/xdata/100">
<Data-Structure Name="Interchange">
<Lookup Name="InterchangeControlVersion">00401</Lookup>
<Lookup Name="InterchangeReceiverID">Interchange Rec</Lookup>
<Lookup Name="InterchangeReceiverQual">01</Lookup>
<Lookup Name="InterchangeSenderID">Interchange Sen</Lookup>
<Lookup Name="InterchangeSenderQual">01</Lookup>
<Lookup Name="Standard">X12</Lookup>
<Property Name="ElementDelimiter">0x7e</Property>
<Property Name="InterchangeAckRequested">0</Property>
<Property Name="InterchangeAuthorizationIinfo">Authorizat</Property>
<Property Name="InterchangeAuthorizationInfoQual">00</Property>
<Property Name="InterchangeChildCount">1</Property>
<Property Name="InterchangeComponentElementSep">0x5c</Property>
<Property Name="InterchangeControINumber">691244239</Property>
<Property Name="InterchangeControlStandard_RepeatingSeparator">U</Property>
<Property Name="InterchangeControlVersion">00401</Property>
<Property Name="InterchangeSenderQual">01</Property>
<Property Name="InterchangeTime">1525</Property>
<Property Name="InterchangeTrailerControlINumber">691244239</Property>
<Property Name="InterchangeUsagelndicator">|</Property>
<Property Name="SegmentDelimiter">0x0d0x0a</Property>
<Property Name="Standard">X12</Property>
<Property Name="SubelementDelimiter">0x5c</Property>
</Data-Structure>
</Internal-Properties>
Please refer to EDI Batching section for handling multiple Transaction Set in an
Envelope.
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Inbound EDI Processing

Depending on the translation flag, B2B translate the inbound native EDI documents to Edifecs
XML to be consumed by the back end application. The Edifecs XML generated also has all
the Document Protocol Parameters mapped to Internal Properties.

Agreement Identification

B2B uses 4 parameters for identifying the agreement From Party, To Party, document type
and document protocol version

Trading Partner Identification

Trading partner Identification can be done in three different ways and order of identification.

Exchange: this is the default way of identifying the trading partner by using the
Exchange headers

E.g. In AS2 protocol, it is by using AS2-From and AS2-To headers and
comparing with the AS2 identifiers of the Trading Partners.

Interchange: EDI has unique values in the interchange headers that can be used
to identify the Trading Partner. (Optional)

Group: EDI has unique values in the group headers that can be used to identify
the Trading Partner. (Optional in EDIFACT)

EDI Value
Interchange Interchange Sender ID
Group Application's Sender Code
Exchange Exchange identifier

/ Note: In order to identify the trading partner based on the Interchange, it is
important to forcefully fail the exchange identification.

Similarly, In order to identify the trading partner based on the group, it is
important to forcefully fail the exchange and interchange identification. This can
be achieved by adding
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Identity From TP Identification Criterion
Interchange Interchange Sender ID (X12 ISA / EDIFACT UNB S002)
Group Application's Sender Code | (X12 GS 02/ EDIFACT UNG
S006)
Exchange Protocol Identification from | (default)
party's exchange identifier

To support this configuration,

e Create a Trading Identification Type: EDI Interchange 1D, EDI Group ID

Profile
& GlobalChips iSave: | Export
The trading partner profile uniquely identifies each partner, Set up identifers, contact information, and customized parameters For each partner,
|§ Confirmation:
GlobalChips has been saved,
Identifiers L4
Identifier types uniguely identify a trading partner and define haw to exchange documents.
Type Yalus
Iarne: alobalChips
ECI Interchange ID - GlobalChips
ECI Inkerchange ID Qualiier w 7z
ECI Group 1D w GlobalChips
Contact Information @ 3
Important contact information For each trading partner should be entered.
Type Walue

e Create a new Trading Identification for the target-trading partner with the

corresponding EDI sender value for Interchange or Group envelope.

Document Identification

Oracle B2B extracts the Document Type and revision from the transaction Set of the
incoming EDI Document i.e from UNH Segment. It is required that the document to be well
formed for the successful extraction of Document Type and Revision.

o X12 - identification based on Group and Transaction set
o EDIFACT - identification based on Transaction set

Validation and Translation
It is required to get the necessary ecs for translation and validation. Document protocol
parameters of the Document is compared against the one defined during Document

definition to extract the ecs file. Typically for inbound messages, Oracle B2B validates the
document and then translates it into xml depending on the settings.

The below mentioned parameters are validated against the configured parameters to
make sure that the data is from the right partner.

Document Protocol Parameters (Header):
e Interchange Receiver ID
e Interchange Receiver ID Qualifier
e Interchange Sender ID
e Interchange Sender ID Qualifier
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e Application Receiver's Code
e Application Sender's Code
e Interchange Control Version Number

Functional Acknowledgement Support in Oracle B2B

Functional Acknowledgment is a confirmation sent by the recipient Application about
e Receipt of the message.
e Status of Validation of the message against the configured ecs file.

Functional Acknowledgement can be configured to be sent by either B2B or by the Back end
application.

e Functional acknowledgement required: Functional Ack required or not. This
option is available while creating the agreement as shown below

&8 Acme_GlobalChips_x12_4010_850_File Save | Validate | Deploy | Export
A B a
Acme g50def GlobalChips
Details
* ngreement 1d | Acme_GlobalChips_12_4010_850_ Start Date [t
*Hame | Acme_GlobalChips_%12_4010_f50_ End Date [5?_[)
Description Calout | %] Callout Details

Agreement Parameters
Validate
Translate

Functional Ack ¥

e Functional Ack handled by B2B: Generates FA in B2B or by the Back end
Application. To enable this,

- Goto Administration
- Click Configuration tab

= Acknowledgment

Functional Ack Handled by B2E [

Functional Ack internal
properties

Makify Inbound Receipt Acks False

false

Motify Inbound Functional Acks False
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Overriding the Document Protocol Parameter for FA.

Consider a use case, which requires overriding the Interchange Sender ID in the Document
Protocol Parameters using the Internal Properties in the Outbound Edifecs Document, or
using the value present in inbound Business message such as 850. To enable the internal
properties to be used in outbound processing, set the “Functional Ack Internal properties” to
“true” in the below picture. This screen is available at

- Goto Administration
- Click Configuration tab

= acknowledgment
Functional Ack Handled by BZE

true

Functional Ack internal False
properties

Mokify Inbound Receipt Acks False

Motify Inbound Functional Acks Falee

This will override the Document protocol parameter value of Functional Acknowledgement
with Internal Property in the generated Functional Acknowledgement.

EDIEL Support

Oracle B2B also supports another variant of EDIFACT, which is EDIEL, used in Electrical
industry. In this case, in addition to all the features of EDIFACT, it is also possible to

e Customise the FA Message Version Number and FA Message Release
Number. The default value for this is D3.

e Provide the reference to the MAP APPLICATION REF, of the incoming message
to be referred as part of FA
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Control Numbers

Control Numbers are included in all header and trailer segments as an additional means of
tracking and confirming EDI transmissions. Control numbers issued in the header segments
must match control numbers assigned in the trailer segments. An ISA control number must
match the IEA control number, the GS control number must match the GE control number,
and the ST control number must match the SE control number in each EDI transmission, or
there could possibly be errors. Control numbers can be assigned in the following two ways.

Control Number along with the sender ID provides a unique identifier to identify incoming EDI
data from a sender. Following are various control numbers,

e Interchange Control Number: Originated by the sender and is typically a sequence
number. This together with the sender ID uniquely identifies the Interchange.

e Functional Group Control Number :This Uniquely identifies Group.

e Transaction Set Control Number : This Unigely Identifies Transaction Set.

Control Numbers are used for correlation at various stages; it may be correlation in the Back
End application or correlation in the B2B application between the business document such as
850 and Functional Acknowledgement 997.

Control Number Generated by Back end Application

This is the most likely case as back end application uses the Interchange, Group and
Transaction Set Control Number for correlation at various levels and also for correlating the
control/Ack and business messages. However, if the translation is enabled B2B can correlate
the business message and functional acknowledgement.

E.g. To correlate 850 EDI message with 997

Control Number Generated by B2B

In case of Outbound Messages, B2B Generates the control number only in case the Back end
application send the EDI message with the macro #controINumber# for e.g.

<Element-329>#ControlNumber#</Element-329>

Oracle B2B fills in the unique number for Interchange and Transaction set Control Number
and uses it for correlating the incoming Control messages.

Note :this is not a preferred approach, as most of the correlation has to happen in the back
end application.
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EDI Batching

Batching of EDI messages allows the users to send all messages of particular criteria at a
specified time. This can include, a set of messages with:

1. Same document type, can be sent to one or more trading partners
2. Multiple document type, can be sent to one or more trading partners

Batching concept is widely used in Retail industry, as the number of messages processed is
high in number. As the Retail traders widely use EDI as the means of communication, the
Batching suits well to EDI domain

Batching EDI Transaction Sets

Individual transactions are sent to the internal delivery channel one transaction at a time. For
outbound messages received on the internal delivery channel, transaction sets can be
batched based on criteria that you specify.

The following example shows how to batch the document type 850, revision 4010, to the
trading partner named GlobalChips. The examples follow the scenario described in the EDI
X12 tutorial

- Go to Administration
- Select Schedule Batch

Schedule Batch

@yschedule Batch Create Batch
Batching is often sed to group messages by dacument type. Use Oracle 626 ta batch, schedule, and send outbound EDI <12 and EDI EDIFACT messages. For example, you may want ko send out a batch of purchase orders or a
batch of invoices

* Batch Name

selected Range IMWALE event ot February 20, 2009 630 AM | Launch Scheduler

ElSearch Advanced Saved Search | Default v

tatch O AIE any
Reesponding Partner | Contains % Document Profocol Version | Equals | %

Agreement | Contans % Document Type | Equals || &
Document Pratocal Mame | Equals (% v Document Definition | Equals || (v
Search || Reset || Save
Initiating Partner Respanding Partner Agreement. Dacument Protocal Dacument Version Dacumerk Type: Dacument Defintion

-> Provide the batch name

- Click on b ckies button to schedule the batch time
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Selected Range
Initiate event at February 20, 2009 6:30 AM

Range

[ Non-Repeating Event . Repeating Event

2[20§2009 6:30 AM B

scheduler [x]

oK Cancel

-> Provide the time range depending on “Non-Repeating Event” or “Repeating Event”

- Click on “Search” button to get the deployed agreements

Esearch Advanced saved Search | Default v
match O Al @ any

Responding Partner | Contains v Document: Protorol Version |Equals (][ [+

Agresment | Cantains v Document Type |Equals v v
Document: Protocol Name [Equas v ~ Document Defirition [Equals (][ (v
Search || Reset || Save.

Inikiaking Partner I Responding Partner I Agreement I Document Protocal I Documert Version I Documert Type I Dacument Definition

Acme: |Globalchips |Acme_clobalChips %12 4010_SEDI R12 4010 |50 [z50def

> Click on @I to create the batch

De-batching EDI Transaction Sets

For inbound message, oracle B2B Splits the interchange into individual Transaction Set and

depending on the Translation flag translate it to Edifecs XML , this is a default behavio
does not require any configuration.

ur and
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Additional features, Tips and Tricks

This section explains few of the advanced topics as well as few of the tips and tricks to handle
the some of the complex EDI scenarios

Custom Code List — EDI

In EDI world, Interchange receiver Id and Interchange sender Id has set of codelist, which is
used to validate the EDI Message. However, it is possible to use the qualifier which is not
there in the standard code list (e.g : ZZ) as part of the Document Protocol Parameter
configuration. This is achieved by following the below steps.

1. Modify the interchange ecs file to add the "YZ" in the standard code list_1005.

2. This can be done by editing the Interchange ecs file in the spec builder and
adding YZ in the ISAIO5/ Interchange ID Qualifier/Standard Code List_1005. Use
the updated ecs while configuring the X12 document protocol parameter as
interchange ECS.

3. Re-deploy the agreement after validation.

4. Ensure Interchange ecs do not have any group/transaction set information.

This could be tested by exhanging an EDI document whose Interchange Receiver ID as ZZ.
This also applicable to all the codelists

Handling Positional Flat File

Apart from the capability of Handling XML file and Traditional EDI file based on various XML
and EDI Standard, Oracle AS B2B also provides an option to Handle positional Flat File.

1. Design the ecs file in spec builder depending on the Positional Flat file.

2. Provide the newly created Ecs file as part of the Document definition Parameter along with
start position and End position while creating the new document for PositionalFlatFile.
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Performance Best Practices

Following are the few of the Best practices for Oracle AS B2B Performance and can be tuned
based on the system resources

Outbound processing:
b2b.outboundThreadCount= <no of threads to be spawned for outbound flow>
b2b.outboundSleepTime= 1000 Sleep time (in msec) for thread when there is no message.

Inbound process:
b2b.inboundThreadCount= <no of threads to be spawned for inbound flow>
b2b.inboundSleepTime= 1000

Default threads for process all the events:

b2b.defaultThreadCount= <no of threds to be spawned for all events such as delivery channel
creation/updating, system parameter updation etc including the message flow in both the
direction >

b2b.defaultSleepTime= 1000

Large Payload Configurations

Following steps need to be configured in case of large payload above 100Mb,
1. As a pre-requisite, the following properties need to be set in B2B
In Admin -> Configuration,
e Use JMS Queue as default property as true.
Logpayload property to be false
Large Payload Size property as <payload size>
Large Payload Directory. eg. /tmp

2. jvm memory-args
e Increase max heap size according to machine available RAM
E.g. for 2GB -Xmx2048m and also change min heap size needy basis.

3. Database Configuration changes
e DBA can tune the db appropriately based on the message flow

3 Comment [ul]: also, we can point to the
performance tuning guide, which will be created for

4. Transaction Timeout settings

In Weblogic console
e Increase JTA transaction timeout from
weblogic console Services -> JTA Timeout Seconds=120 seconds
e Increase SOADataSource XA timeout setting to 120-180seconds
weblogic console Services -> JDBC->DataSources-
>SOADataSource
5. Fabric settings - For fabric based testing use streaming option incase of file-adaptor
listener.
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Oracle B2B Document Editor

Oracle B2B - Document Editor (Powered by Edifecs™) is an integrated guideline creation and
implementation application for business-to-business (B2B) electronic commerce (e-commerce).
Use the Document Editor to simplify developing, migrating, testing, distributing, and printing your
electronic business (e-business) guideline documents. You can create new guideline documents
or use the Document Editor's comprehensive library of Standards as templates.

Using an existing standard as a template, you can create new transaction sets by changing the
attributes of underlying segments, elements, and codes as well as create implementation
guidelines from data files. Oracle B2B - Document Editor is also integrated with Edifecs
CommerceDesk, the most complete solution available for data generation and guideline-
compliance testing.

In order to use the EDIFACT, X!2 and HL7 protocol in ORACLE integration B2B, it is mandatory
to know below mentioned basic steps

Creation of ECS files using (SPEC BUILDER 6.6.1)
xsd generation using ecs file.

Data generation using ecs file.

Analyse the data

CREATION of ECS files USING SPEC BUILDER 6.6.1

Prerequisite: Install the spec builder 6.6.1
- Open the spec Builder 6.6.1

Powered by

§EDIFECS.
SpecBuilder..

Ae DX O
Open Document
Analpzer

Migistor

Data Benersior
B
1

Deta Edior

Data Dicionay Edloc

Dt Ditiriay Genetato]

o

Standards Felerence

108

el
Additional Offering

- Click “New document” to create the new ecs file
- Select guideline as EDI, X12 Documents
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B Mew Document Wizard

Mew document creation
Fleasze select a guideline

=, | |-y SIMPLEDI ]
== DTD
== Delirited Flat Fil=
&[]
LHLT
E HL7+3
E WCPDE - Health Care
=N - Life & Annuity
=] ParserSchema _I - Property & Casualty
[ i it
12 Documents
< Black | [t = | Cancel | Help |
4

- Click on (+) to select the desired Document Protocol Version (V4010)

Ei New Document Wizard

Mew document creation
Fleaze select a guideline

LoD

(" Delmited Fla File

LT

[ HL?3 001 - Cantral § egments

E WCROP [& 100 - Insurance Plan Description

= 107 - Mame and Address Lists

[ ParserSchema B 10 - &ir Shinment Infarmation i
= W =l | b
/4010

< Black | [t = | Cancel | Help

-> Select the Document Type (850 — Purchase Order)
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New document creation
Please select a guideline

=8 DTD ~ 841 - Specifications/Technical Inform: A
lg 842 - Nonconformance Report
] Delimited Flat File 843 - Response to Request for Quotat
= B 844 - Praduct Transfer Account Adjus!
{4 EDI

845 - Price Authorization Acknowledar
& HL? 846 - Inventory Inquiry/Advice
= 847 - Material Claim
g HL73 843 - Material Safety Data Sheet
& NCPDP 849 - Response to Product Transfer A
= 850 - Purchase Order
sl ParserSchema M AR1 . Accat Crhadila het
[~ | |85 | 2

850 - Purchase Order

I Next> I Cancel Help

- Unselect the Envelop.

Oracle integration B2B is pre-seeded with all versions of the envelope
and group ecs files. Hence no need to generate the envelope and group ecs files
| Unless there is a deviation from the standard

El New Document Wizard E]

New document creation
Please select Envelope Segments

& From Envelope Database «

K12 -¥4010 - 850 - Purchase Order 2

| Envelopes | | Breview
B4 ! . ol -
= ptional seg & 52
|
4 ptional seq
= 5
i} ional seg Ea
& o v

S
|

< Back I Finish | Cancel Help

- Click finish
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R SpecB - Oracle B2B - [X12-¥4010]

Bl Edt Yew Tods Wedow Heb

<@ 010 Traneaction SetHeader 4
+ @M BEG 020  Begrring Segment for Psc E General
R o e = —
“ @RREF 050  Relmencs Idsificshen i
o @AFER 060  Adwinstiotive Communicat Name: [Purchase Order ]
S @ TAX 070 TacRelesenca Functionsl
SRUFID 00 FOB Assedinsnctins G BN
# @ CIP 00  Picng Infomation Standard: Vversion:  [V4010 ]
*@APAM 095 Peiod Amount
# @B CSH 110 Saes Requiremert: B Notes
=@ 115 Commedly Purpose v
o @8 SAC 120 Service, Promotion. Alowar
“@AID 120 Tems of Sae/Delened Ter et [T Draft Standard for Tral Use contains the
S2el | [format and establishes the data contents of the
RERDE 14 (Disouni Dol CEEESS | 7. -chosc Order Transaction Set (8S0) for use
«@AINC 145 Instalkment Irfomation |within the context of an Electronic Data
“@AOTM 150  Dele/Tme Aedeience [Interchange (EDI) environment. The transaction
+ @30T 160 LeadTime |set can be used to provide for customary snd
S@IUN 180 lemideoticaion lestablizhed business and industry practice
[reiative to the placement of purchase orders for
“@s 18 Sercs Chuecluntls g |ooods and services. This transaction set should
S@AFD 190 Product/em Desciption [not be used to convey purchase order changes
= @I MEA 200 Messurements Jor purchase order acknowledgment information.
¢ @PWK 210 Paperwork
“ @AFKG 220 Making Packagng, Loade
+@01 20 Cam
“ @105 240 Camer Detais Routig Seq
* @170 250 Comes Detois Ecupment]
+ @2 D4 260 Cavir Dotais (Special Han ¥
< >
ooy T
#0Guideline [35 T[]\ Properties /{User Nz )\ Pakes J, Chiden J Aralyzer 1 s ]

Edit the segment level details as per your requirement.

-> Save the generated ecs file.
CREATION of XML Schema Definition (xsd) for the ECS file

This step is used to create the XML Schema definition.

- Open the newly created ecs file

- Click on File=»Export

- Select Oracle B2B 2.0 as export format. This export routine will convert the guideline from the
internal format to one that can be used with the Oracle B2B runtime software 2.0.

’E\e Edt Yiew Iools Window Help
PaERS||sme| x

Transaction Set Header
Beginning Segment for Purc
Curency

Reference Ideniiication
Admiristrative Commuricay

B
5558

EH

Export Wizard

3

BEREESE

Pricing Information Welcome to Export Wizard

Peiod Amount

Sales Requitements This wizard helps you convert a SpecBuider guideline into

Commodty extemal formats for use with other applications.

Sewvice, Promotion, Allo

Temms of Sale/Deferred

Discount Detail HTML with Branching Diagiam

Installment Information Mendelson Transformation Engine Format
Dracle B28

23329

Choose an export o perform:

z9
B

Date/Time Reference
Lead Time Pervasive XML

Item Identification Standard Exchange Format (SEF)
Service Characteristic 14 TIE Mapping Manager Format (EMM)
Product/ltem Descriptior

Measurements Description

s3ecEy
(g9 =32

2

Peperwok [This export routine wil convert the guideline from the.
Marking, Packaging, Log intemal format to one that can be used with the Oracle.
Carier Detais (Quantiy & B28 runtime soltware 2.0.

2

28825

Carer Details (Equipme
Carier Detais (Special Hj

] i | New> Concel | Hep
Shoace T T 17 T\ Properties A, User Nals \ Fues J\ Children J\ Aralyzer { Dsta /.

ofof el o] olaf ool afsfaf ool o] - faf o of af ol af o of af o] o)

3328

- Click Next
-> Select the option of saving the guideline before exporting.
-> Select the location for saving the exported file
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1% 850.ecs - Oracle B2B - [X12-V4010]
IE
pacps||sme|s xainz2esr|[eBneene |||

Transaction Properties

Edt View Tools Window Help

Category | Reset Changes | Apply

Guideline - -
@ ST 010 Transaction Set Header
+ (2 BEG Beginning Segment for Purc = General
*@CUR 040 Curency
::) REF 050  Reference Identiication
® @ PER 060  Administiative Communicy ame:
@ @ TAX 070 TaxReference Export Wizard
=@ FOB 030 OB RelatedInstuctio
@ @ CTP 090  Picing Information Export
® @ PAM 095 PeiodAmount Expot destination
CSH 110 Sales Requirements
€2 115 Commodty
SAC 120 Service, Promation, Allow

130 Tems of Sale/Defered Save expoted Flo a5

CA850.x5d

145 Instalment Information
150 Date/Time Reference
160 Lead Time

180 ltem ldeniication

185 Service Characteristic 104
190 Product/tem Desciptiorf
200 Messuements

210 Papemwork

220 Marking, Packaging, Lo
230 Carer Detais (Quantiy
240 Carier Detais (Routing

¥ Save guideline before exporting

atier
260 Carier Detaiks (Special H

0 | <Back Newt> Cancel | Hep |
by, T T T\ Properties A User Notes J\ Rules J, Ghiden \ Analyzer  Dota /

- Select the option for namespace generation as “Custom namespace”

- Provide the custom namespace as “urn:oracle:integration:b2b:X12/4010/850”

WX 850.0cs - Oracle BZ8 - [X12-V4010]
e Edt Yew Tods Widow Heb
RAE QA8 388 v xH N 2LSR | BREACRES ||?

ST 010 Transaction SetHeader A
BEG 02) Begrring Sementfor Pusc
wR o0
REF 050 Relsanca ldsaificaion
PER 080  Adwinshishve Co "
TAX 070 TaxReieonce
FOB  06)  F.08. Aelated Iniuctiy
CIF 020 Picng Infamatin

0%

Pioase corfigue XSD namespace generation:

PEFREFIEHERICITNIFAEPHEDS

Fan
CSH
2
sac
1TD 130 Terms of Sale/Delered §
oIS M40 £
INC 145 Instaliment Infosmation
DIM 150 Dale/Tive Reference
LT 160 LeadTine
w1 T ey
Sl 185 Servin Chavactesiolod !
FID 190 Froduct/lem Dezcrtor 1™ Add uicus
MEA 200 M 3 .
PWK 210 Pepemwark b ssoeon e
PG 220 Making Packogig Lod (arcorasie niepahon B2LX1 /401070
T 230 Camer Detaks (Quarity 4
05 240 Comer Detais Routing 9
@03 20 Coer Dot Eaupmer]
S @RTDI 260 Camer Dot (Specil
<Bok [ Met> | Coeel | Heb |

|

T T\ Properties 7 User Nokes )\ edes  Chtdren ) Analyzer 1 Dot |

- Click Next
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Export
Select name templates configuration

Templates:

HNode Element 2ol

Transaction i-=Node D= sl

Loop ~=Node D> =

Segment -=MNode D=

Composite -<Node ID= = ‘
|

Element ~<Node D= v

[ Abbreviated element name prefix

Preview:; l<element name='Transaction-<Node |D>' type="Transaction-<Node ID>" ...#>

J) Templates are loaded from the registry

< Back I Nest > I Cancel Help

- Click Next

Export
Please select common conversion options

Please select common convesion options:

BReplacement character: Underscore ' ad
Internal node name separator: |Dash ' v
™ Suppress Enumeration in XSD

[~ Add offset and size to leaf XML elements

™ Suppress use of optional attributes in XSD

IV Use this export module instead of default during XD ata generation. Templates
will be saved to the guideline file and will be re-used next time

< Back I Next > l Cancel Help

- Click Next
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Options

Export SpecBuilder ECS D t to XML Sch: Opti
Select proper options

Please select EDI specific convesion options:

v llow to use SegmentCount macra

[ Don't use xsd:choice for keyed segments/loops

< Back I Next > I Cancel I Help

- Click Next

Export
Please select server %

I Launch Oracle B2B console after export

< Back I Nest > I Cancel Help

- Click Next
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,

Export
Please specify macro nodes

Name | UPath

< Back I Next > l Cancel Help

- Click Next

Export Wizard @

Export
Exporting the document

" Converting to Oracle B2B. 2.0

Finished
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DATA GENERATION USING ECS FILE.

This step is used to create the test data.

- Click on Data generator in the left pane of the below screen.

Oracle B2B.

DOpen Dactiment
2
Analyzer

2N

Migialor

Data Edtor

o

ifiz!
Data Dictionary Editor

Dt Dictionay General

Standards Reference

e
Additional Offerin

o8

ORACLE' B2B Document Editor Powered by
§EDIFEC:
SpecBuilder

Ae X

Data Generator Wizard x|

Welcome to the Data Generator Wizard

A Test Case is a callection of ssltings used to generate test dats based on a quidsline. 4 saved
Test Case can be 1eused later to generate additional test data files.

A Generation Task is a collection of Test Cases. |t enables automated generation of multipls data
files

Please select one of the following:

@ Mew Test Case

€ Exigting Test Case

Select the Generation Task file

[T RunAnalyzer sfter D ata Generatar
¥ Show Advanced Options

< Back I Mext > I Cancel Help

- Click next
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& Data Generator Wizard x|

Create or update data file
Flease select a Data Generator Test Case Action

Data Generator can either generate new data or update an existing data file using specified data dictionaries

Please select the action Data Generator should perfarm:
' Generate

€ Update
Flease specify the data e that should be used as the base file during data generstion. This fie willbe fist parsed and
analpeed!

| B

Spesify data file type

[em =l

Cancel

< Back I Nest > I

Help

- Click next
- Since the data is generated for user defined guideline, select the option as “From a guideline
file”
B Data Generator rd x|
Guideline selection
Please telect a guideline
© From the database 1+ Fiom a guideline file
Lookin [ Guidslines |« & ek E-
l|Rn110rder.ecs
11g_ecs_files 2l Specl.ecs
2856, 805 =] Specz.ecs
5] ADAO1 . Ecs I Speca ecs
5] Adtz.4.ecs I TestHL.ecs
21 ADT_AD1_xsd.ecs
=l | AMERIPATHguideline_xsd.ecs
= |EDT.ecs
=I'| EnvelopFile-HL7-2.5.ecs
51| FileWithBatch.ecs
=l | Finall .ecs
=] | Final.acs
51| Generic.ecs
51 quideline_xsd.ecs
File name: I
Files of type: [ SpecBuilder fles [*.ecs) = |
< Back e > Cancel Hep |
4

-> Select the newly created ecs file
- Click Next
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Envelope Segments
Pleaze specily Envelope Segments

& Data Generator Wizard

options:

' Use Envelops Segments from the sxtemal guidsiine file

" Use Envelope Segments from multiple guideline files

@ Select Envelope Segments from the Standards Database

Thg selected guideline does not have Envelope Segments. Ta use Envelope Segments please select from following

< Back I Newt > I Cancel

Help

- Click Next

Envelope Segments
Please select Envelope Segments from the database

%12 - 4010 - 850 - Purchase Order
Envelopes

Preview

[ 00502 - with optional segments
2 00501
[ 00501 - with optional segments
[ 00406
[ 00406 - with optional segments
[ 00405
9 00405 - with optional segments
00404
4 00404 - with optional segments
[ 00403
[ 00403 - with optional segments
[ 00402
£ 00402 - with optional segments

r=Yooor]

2 NN4N1 - with antinnal seaments

v

|_] 850 - Purchase Order
(Z3 154 Interchange Control Header
£ GS Functional Group Header
[#8 ... Objects ..
([T GE Functional Group Trailer
(Z3 IEA Interchange Control Trailer

< Back | Next > I Cancel

Help
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Data Generator Wizard

Envelope Segments
Please specify how to use the selected Envelope segments

How do you want to use the selected Envelope Segments?

" Insert in the guideline.

& Used directly from the Standards DataBase.

" Save as External Envelope Segments guideline that can be reused later:

< Back I Next > I Cancel | Help |

Data Generator Wizard
Data Generator options

Please select data generation options

These settings determine how optional data is generated

€ Mandatomy data only

" Mandatoy + Optional data in the dictionary

' Mandatory + Percentage of optional data

I
i 4 .
No optional data All data

Select the property to be used to determine if item is mandstory or optional

" User Option

" Standard Option

< Back I Mest > I Cancel Help
4

- Click Next
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B Data Generator Wizard

Element Size
Please select Data Generator Element Size option

-> Click Next

Index Reset
Please set Data Generator Index Feset option

->Click Next
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Data Generator Wizard

Repeat Count

Please set D ata Generator Repeat Count option

Please et the Repeat Count option ta contral how many messages to generate:
Transactions: -

Functional Groups:

Interchanges:

ol

< Back I Next > I Cancel |

Help

- Click Next

Data Dictionaries

Please select Data Dictionaries to use by Data Generator

0
Sample_4010_856
Sample_D374_Orders
Sample_HIPAS_276

Data from dictionaries listed first will be used first.

< Back I Next > I Cancel

Help

->Click Next
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- Provide the desired delimiters or select the segment separator as shown below

Delimiters

ata Generator Wizard

Plzasze set delimiters to use by Data Generator when generating data file

Edit delimiters (] [
Name Ascil Value Hex Value

Segmert Terminalor : 77

Element Separator -~ TE

SubElement Separatar i aC

Repetition 5 eparatar * 28

Release Character 7 F

Decimal Indicatar 2E

I~ Specify filler characters

< Back I Next > I

Cancel Help

-> Click next

- Select the output data file name

"~
58 Data Generator Wizard r_

Test Case Save

Please save the Test Case

v Dutput Data file name

Ic:\BSU.dat

[~ Save Test Case to the Generation Task file

< Back I Next > I

Cancel I Help |
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- The data gets generated

|Hle Edt Wiew Tooks Window Help |
pad R me|. xn 6 2esn | REDEREW |2
| Guideline
010 Transaction Set Header 4 i Group 1 8
020 Beginning Segment for Purc {31 G5~P0~Applcation Ser“Application lec™20070727~194136~1""
040 Curency /&Y Transaction 1 3
B! 050 Refetence Ideniiication @157~850+0001 &
“@APER 080 Adninitative Communicati (] BEG007AB"1 Number 00707 ~AC~BM~01~AE 0001
# @ TAX 070 TaxReference () CUR~01~CUR~223491 ~01~CUR~IMF~001~20070727~1941~001~20070727~13413600~001~20070727~1941~001~2007C.
# @ F0B 030  F.0.B. Aelled Instuctions @8 REF~01- feston*Descilion” 195 &
“@CIP 090  Picing Infomalion e & S
2 (51 PER~1A"Name™A"C 0 r“Contact Inquiy Refe
# @ PAM 095 Period Amount i N 3 b e s
“ @ CSH 110 Sales Requiements ETAT, AL Al w1l “A~Location|
T2 115 Commodiy q | (31 F0B~11~A~Description~01~CAF~ADescription™BY~Desciption
w8 SAC 120 Senice, Promolion, Alowar @ CTP-AATACT 15064"94103 121
# @D 130 Temsof Sale/Deferred Ter @ pam-o1 ! AN il 108
“ @ DIS 140 Discount Detal (&) CH~B~1~143"Account Number~20070727-10~AC~A™19217295~1
# @ INC 145 Instalment Information &1 TC272~Commodiy Code
# @ DTM 150  Date/Time Reference . E&a {Loop SAC}H
“ @ DT 160  Lead Time | @) SACTAAI 010 Agency Ser2630520641~ 264831801 7437201 01 ion
@ UN 180 hemldentfication - 9 (@ CUR™D1~CUR~43839~01~CURIMF~001~20070727-19413700~001 ~20070727-1941~001~20070727~1341~001~200
®@ Sl 185  Service Chaacteiistic Ident 7 (] 1TD~011+2935~20070727 119200707271 3770101 2007072723153 Description™19™1~1687130136.
#@PD 190 Product/tem Description 2 @1 DISAMT~CA~B066~DAT 152027129
@ MEA 200 Measuements | BEIINCT0101M51 720136301 13267\014311527234\01 ~28913+1344414°2189728
“ @ PWK 210 Paperwork &) DTM~001~20070727~134137~01~CCDate Time Period
“@APKG 220 Marking. Packaging, Loads (5 LDT~4~21024310665246 4420070727
= @101 230 Carier Details (Quanty anc & LN A1 ~a1 T 1 ~a
# @1 T05 240 Caries Deas (Routing Seq @R A 2 ERe i 2R al
%@ TD3 250  Carer Detais (Equipment)
@1LIN 1 1 1 1 8
TD4 260 Carier Detais (Special Han
e a i (Speci 3 (1 51710°5e™ S et e e v
< T ] >
B $ >
b [ ST 2T5TN Properties ) User Notes \ Rules \ Children ) Analyzer # Data /

- Save the data file
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ANALYSE THE DATA/ VALIDATE THE GUIDE LINE
This step is to analyze the test data.

- Click on Analyzer in the left pane of the below screen.

Oracle 828
$ ORACLE' B2B Document Editor

Hew Document

i Powered by

SpecBuilder..

Ae DX

Data Generator

Data Dictionaty Edice

Dats Dictoiry Genetato]
v
Standerds Relerence:

S

e
Additional Offerings

- Select the file to analyse

k”‘El Analyzer Wizard @

Welcome to the Analyzer Wizard

This wizard helps you to validate a data file

Select data file to analyze:

1850 da Bl
Specify data file type:
[eDI =l

V' Show Advanced Options

| Next> | Cancel Help

->Click Next
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&1 Analyzer Wizard

Clean Up Data File
Please select how to use Preprocessor

Some data files may require preprocessing. Please check this option to prepare the data for parsing

< Back I Next > I Cancel Help

~>Click Next
B Al*]lyzer Wizard
Data Structure E
Please select node to link Avalidate E‘

Data node name:
EntireDocument

=-{_] Interchange
=] Group

& . Data node properties:
(L Transaction

FileName: 'C:A\850.dat'
TaskID: 'C:AB50.dat'

Data node links:
Node start position = 0(0x0]

Node size =19540(0=4c54)
Node end position = 19540(0x4c54)

< Back I Next> | Cancel Help

->Click Next
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- Select the guideline (ecs file) to check the correctness of data against the newly generated ecs

file.

& Analyzer Wizard [2]

Guideline selection
Please select a guideline

Data file matches to the selected guideline from Standards Database. At the same time you can choose another one
from Standards Database or provide a custom guideline.

" From the database
Lookin: | Guidelines ;'J « @ ef B

File name: |

Files of type: | SpecBuilder files (*ecs) =l

< Back i Cancel Help |

->Click Next

Since the ecs file does not contains the envelope segments choose the below mentioned options

B Analyzer Wizard

Envelope Segments
Pleass specify Envelope Seaments

The selected quidline doss nat have Envelops Segments. Ta use Envelope Segments plaase selsct from following
optiors:

% Selact Envelops Segments from the Standards D atabase

" Process withaut Envelaps Segments

" Use Envelope Segments from the extemal guideline file

' Use Envelope Segments fram multipls guideling files

< Back I Mext > I Cancel Help

->Click Next
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1 Analyzer Wizard

Envelope Segments

K12 -V4010 - 850 - Purchase Order
Envelopes

Please select Envelope Segments from the database

Preview

3 00501
[ 00406
= 00405
3 00404
[ 00403

= 00402

=} 00401

g 00502 - with optional segments
£g 00501 - with optional segments
3 00406 - with optional segments
B4 00405 - with optional segments
B4 00404 - with optional segments
3 00403 - with optional segments
B4 00402 - with optional segments

2 NN4NT - with antinnal seaments

A |1 850 - Purchase Order

= {8 ... Objects ...

1S4 Interchange Control Header
GS Functional Group Header

GE Functional Group Trailer
|IE4 Interchange Control Trailer

< Back I Next > I Cancel Help
- Click Next
Envelope Segments
Please specify how to use the selected Envelope segments
How da pou want to use the selected Envelope Segments?
€ Ingart in the guidsline.
" |sed directly from the Standards DataBase
€~ Save as Extemal Envelope Segments guideling that can be reused later:
< Back I Mexst > I Cancel Help

-> Click Next
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rd

= Analyzer

Analyzer Mode and Dutputs
Please select analyzer modes and outputs to generate

nalyzer Oplion:
& Run Linker and Validatar € Run Linker only

Masimum number of srors o repart: (100 ¥ Limit rejecting erors only

"Large data fila mod ‘

™ Invoke large data file mods I™| Generate short report
r~ Dutput
™ Generate Logical Data Report Generate XData ML |Alwaps

Files will be stared in the temp folder set in Tools->Options. They wil be deleted when SpecBuilder application is
closed. | you wish to save files please do so prior to closing SpecBuilder.

¥ Allows tailing spaces in String/alphatlumeric fields

< Back I Mext > I Caheel | Help |

A

-> Select the option to “generate Xdata” as “Always or No Errors” in order to generate XML

Data
->Click Next

R 850.ecs - Oracle B28 - [X12-V4010]
Ele [dt View Jods Wndow Heb
poafae |1 ne v xnjAl sesn | [aBRER RS |2

P B
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- Analyser will provide the analysis results with error messages (if any), in the bottom pane of the

above screen. In case of error edit the data, save and execute analyzer.

->Click on the

button in the top right corner to view the XML Format of the data
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Print and Publish Specifications

The objective of this section is to create, customize and publish an implementation /
companion guideline.

- Click "New document" to create the new ecs file

->Select guideline as EDI, X12 Documents

- Click on (+) to select the desired Document Protocol Version (V4010)
- Select the Document Type (850 - Purchase Order)

- Envelope Segments: Select - default, Click Finish

Note: either you can create a new guide line or use the existing one

1. Include/Exclude Node

In the Guideline tree
Expand segment BEG Beginning segment fro Purchase Order.
Exclude element BEG06 Contact Number

2. Adding user note for ISA segment, ISA08 element.
Expand Segment ISA Interchange Control Header
Select element ISA08

Select ‘User Notes’ tab and then

[}

[e]

User Note 1: Add Note

Value in this element must equal:
RealProcess for real-time purchase orders
BatchProcess for batch purchase orders

User Note 2: Add Note:
Ensure that values match either “REALProcess “ or BATCHProcess”.
When value is “RealProcess” only 1 purchase order is in the data file.

3. Modify User Note Labels.

Select File > Document Options

Select “Notes” Tab.

Scroll down on the tree to find the entry for Element Notes.
Change label for User Note 1 to “TP Note”

Change label for User Note 2 to “Dev Note”

Click Apply

Select “Composite/Element” Tab

Scroll down to section “Print composite/element user notes”
Enable printing of TP Note and Dev Note

Click Ok

¥ Note: Label on the screen has also changed to “TP Note” and “Dev Note”

4. Modify Cover Page

Select File >Properties.

Change Title to ABC: 850 Purchase Order”
Change Author to “ABC”

Click OK

Select File>Document Options

Select check box to “Print Cover Page”
Click OK
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5. Save Guideline
e File-> Save
e File: Les7_X12_4010_850_Notes.ecs

6. Print Preview

Select File > Properties
Verify

Cover Page

Exclusion of BEG06
ISAO8 notes

7. Publish to HTML, PDF, RTF, Word XML, Excel XML (optional).
e Select File >Publish To.
e Select “HTML”
o File: Les7_X12_4010_850_Notes
e Using Windows Explorer navigate to the location provided for the HTML page.
Double click to open the HTML page. And verify edits
e Exit Specification
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Write and Test Business Rules Using Java Script

The objective of this section is to write rule using java script for additional business rule
validation

Note: JAVA Code is available in the attached sample. zip file under
\B2B_Class\Document_Editor\java_code.txt.

- Click "New document" to create the new ecs file

- Select guideline as EDI, X12 Documents

- Click on (+) to select the desired Document Protocol Version (V4010)
->Select the Document Type (850 - Purchase Order)

- Envelope Segments: Select - default, Click Finish

1. Write rule that accumulates the line item quantities
If the total quantity does not match the count in the control segment then report an error.

2. Create and initialize quantity accumulate variable.
e Select the root Transaction node in the guideline tree.
Click on the “Rules” tab on the detail pane.
Click on the icon to add a new Rule
Select “User Global Declaration Script”
Add java script variable declaration:

abc totQuantity = 0; |

Guideline :
) X12 Guideline A||Rue  ||user Global Declazatiorn:
=459 V4010-850  Purchase Oi b3 iser Global Declaration Script // User global declaration area is u
=8 154 Intercha /7 1) To reference JavaScript functi
=& GS Functior /7 2) To declare variables which wil
=& ST 010 Transa // 3) To declare common user functio
@ {E) BEG 020  Beginnir
=) CUR 040 Curenc abe_totQuantity = 0;
#{E REF 050  Referen
=) PER 060  Administ
w8 TAX 070 TaxRet
& FOB 080 FOB.F
=@ CTP 090  Pricing|
# & PAM 095 Period2
@ CSH 110 SalesRiy -
R I— .’.IJ I - | ,___Q’I:l
= o Y 4 > Ln 6, Cal 11
T[4 [ TRL], Propettes )\ Rules / Ghildiew J Aralyzer /Dt 7

3. Write code to accumulate quantity for each line item loop

In the guideline tree

Expand Loop PO1 “Baseline ltem Data™
Select segment PO1 “Baseline Item Data”
Select element PO102 “Quantity Orders”

Click on the “Rules” tab on the detail pane.
Click on the icon to add new script.
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e Select “OnUserNode Script”
e Add code:

abc_totQuantity = abc_totQuantity + parseFloat(ec_Datalink.m sData) ;

Guideline
E3P01 010 Baual||Bue |+ User Global Declaration:
~@ss o 2 OnUseode Seript
= [=lonUsezNoade ()
[ﬂﬁ 355 03 // User JavaScrapt code an this sectai]
@22 04
=@ 639 05 abe_totQuantity = abc totQuantity
[ﬂ@ 235 06 _J + parseFloat (ec_DataLink.m_sDat:a) 3
= e BT
FE 23 08
~E@ s 09
=@ 23n 10
~E 23 N
=& 23s 12
[ES (= ek B v =
K > 1 »
3 l » [ néCall
%0 5
(e T4 L1251, Pronettes )\ Rules £ Ghiaview Jy Aralyzer /Do /.

4. Write code to report error: Total quantity <> total quantity calculated.
In the guideline tree
e Selectsegment CTT  “Transaction Total”

e Selectelement CTT02 “Hash Total”
e Click on the “Rules” tab on the detail pane.
e Click on the icon to add new script.
e Select “OnUserNode Script”
e Add following code and save the .ecs file:
if (abc_totQuantity != + ec DatalLink.m sData)
{
var ErrMsg = "Calculated total Qty: " + abc totQuantity + " does
not match the reported Qty: " + ec DatalLink.m sData;

ec ErrorContainer.AddError2 (" _ec CaseID", "9999",
" ec DescriptionTemplate", ErrMsg);

}
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Guideline
w @@ N 310 Name af [Pude | #User Global Declaration:
w8 M 430 CodeSc 2 OnUseNode Seript
w8 5P 450 Spesiic [=lonUsezNode ()
=8 ADY  B10 Advertis // User JavaScript code in this section is executed g
{8 P01 010 Baseline
E‘a CTT 010 Transac if (abc_totQuantity != + ec Datalink.m_sData)
L ECcTT 00 Tar ¢
E 354 0 war ErrMsg = "Calculated total gquantity:
=337 02 + abc_totQuantity
E a1 03 B + " does not match the reported guanity: "
& /04 + ec_DatalLink.m sData;
@1 05 L ec_ErrorContainer.iddError2 ("_ec CaseID”
& 355 06 , "9899", " ec DescriptionTemplate"”, ErrMsg):
@}/ 7 . 3 =
4 | » Ral | e
i 4 | [ 10, Cal il
020 ,
| inte T4 TR TRI Properties A Rutes £ Childview  Aralyzer { Data

Compare customized specification to the standard specification

The objective of this section is to compare and migrate customized specification to a newer
version of the transaction.

1. Launch Migrator
e Launch B2B Document Editor.
e Open the main toolbar to the left and click on the icon for Migrator

2. Executing the comparison and migration wizard
e Migrator wizard is started.
e Source guideline from the database or standard
o Select Standard
= EDI, X12, Version 4010, 850 Purchase Order

= Click Next

e Select Destination Guideline or Standard
= File: Les7_Migrate_X12_401_850.ecs
= Click Next

e Comparison options
o Allow customization of which guideline attributes should be compared
and which should be skipped. By default user notes are skipped since

they will most likely always be different. Use the default settings and
click Next.

e Migration options
o Allow customization of which guideline attributes should be migrated from
source to target. Use the default settings and click Next.
e Match options
o Allow customization of how the two guidelines should be linked to each
other. By default node ID is used for linking but additional attributes such
as Name and Position can also be used for linking. Use the default
settings and click Next.
e Click Finish to start the wizard.

3. Viewing and navigating differences
e Use the scrollbars and the toolbar icons to navigate to next / previous differences

F X
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4. Printing comparison reports.

Using File->Print Preview view the:
o Change summary report
o Companion reports

Reverse engineering specifications using existing data files

The objective of this section is to demonstrate how to create specifications from existing data

files.

5. Launch SpecGenerator.

Launch B2B Document Editor.
Open the main toolbar to the left and click on the icon for SpecGenerator.

6. Executing the SpecGenerator wizard

SpecGenerator wizard is started.
Select the data file:

o File: Les7_850_2.dat

o Click Next
Clean up data flies: Click next
Data Structure: Click next
Guideline Selection: Verify that the proper guideline from the database is
automatically selected and click Next.
Envelope Segment

o - Please select Envelop Segments: Click next

o - Please select Envelop Segments from database Click next

o - Please select how to use the selected Envelop Segments
SpecGenerator Mode—-> Click next
Order specification based on the content.
Toggle the view to only view included items by clicking on the toolbar icon.
View the N101 code list to verify the code values are limited to those present in
the data file.
Save the specification document as Lab7-850.ecs and close the guideline.
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Typical EDI Errors

1. Unable to identify the Document
Make sure the document EDI document is well formed by using B2B document editor

2. Agreement Identification which involves Document Identification and TP
Identification

Agreement not found for trading partners: FromTP GlobalChips,
ToTP Acme with document type 850-4010-INBOUND

Check: Make sure to verify Trading Partner Name, Trading Partner Parameters
(Optional), Document Type Name, Document Type Revision, Trading Partner Id, Delivery
Channel

3. Document Validation Error
Check: 1. Make sure Document Protocol Parameters and matching values.

Proper ECS file is used for Validation
4. Connection Issues

Transport error: [IPT_HttpSendConnectionRefused] HTTP connection is refused.
Connection refused: connect

Check : Make sure the information about delivery channel is correct and also the end
point is active. Pinging the end points can do this.
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FAQ

1. Isitalways mandatory to send the Edifecs XML to B2B for EDI processing?
It is possible to process Native EDI, Edifecs XML and any other flat file using Oracle B2B.
Following are some of the features with native EDI/Flat File Processing.

e Translation should be switched off with optional validation.

e Oracle B2B would not provide features such as Batching, etc. with this
configuration.

e ltis required to send the complete envelope, as Oracle B2B will not generate the
envelope using Document Protocol Parameters like in case of Edifecs XML
processing.

2. What if | have a native EDI file in the back end application can | process in B2B?
Refer to Q1.

3. What if | have a EDI document with multiple transactions, how do | handle in B2B?
Oracle B2B Processing is based on Transaction set, hence it is required to split the
envelope into multiple transactions and send it to B2B. B2B translates the transaction set
into native EDI and generates the envelope using the Document Protocol Parameters.

4. Can | receive EDI document with multiple transactions from a trading partner?
Yes. Oracle B2B provides a feature of debatching for inbound messages. Refer to section
EDI Debatching for more details.

5. Can | outbound batch a native EDI documents to be sent to B2B from Back end
application?
No, Refer Q1.

6. Can | customize the group and Interchange ecs files? How?
Yes, it is possible to customize Group and Interchange ecs file using Oracle B2B
Document editor and upload the same at the trading partner level.

7. What is the preferred Exchange protocol for EDI?
EDI won’t mandate any Exchange protocol as such. However AS1/AS2 are the most
popular exchange protocol which go well with EDI.

8. Can | disable the validation of incoming data against the document protocol
parameter? Is it possible to identify the incoming document only based on ecs
file?

Yes, it is possible to disable the validation of incoming document against Document
protocol parameters by setting the value for “Ignore Validation on Envelop elements”

El Miscellaneous
Default Trading Log Payload false
Fartner
Ignore Reconne;t on False
Validation on rror
Envelope HTTP Header =
elements Delimiter
Ignqre false Treat Reply To False
Correlation message 35
Additional Request
MIME Types

9. Is it mandatory to have Functional Acknowledgement in EDI.
No it is optional
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10. What happens when the Document related parameter are modified in the admin
page when it is already being used in the trading partner level. Can the updated
information propagate to all the trading partners ?

NO
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Reference Information
Links

Oracle B2B
http://www.oracle.com/technology/products/integration/b2b/index.html

Oracle B2B Forum
Forum: http://forums.oracle.com/forums/forum.jspa?forumiD=242

Fusion Middleware
http://www.oracle.com/technology/products/middleware/index.html

Service-Oriented Architecture
http://www.oracle.com/technologies/soa/index.html
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